
Adobe Flash Professional Guide
How to publish a Flash document
You develop content in Adobe Flash Professional by using a Flash FLA document. These documents have a .fla 
extension and can be opened and edited in Flash.

For other people to see your movie, you publish it in a format that is accessible by other software. You use the 
Publish Settings dialog box or the Publish section in the document Properties panel to determine which formats to 
publish.

Publishing a Flash document for the web

By default, the Publish command creates a Flash SWF file, an HTML document that inserts your Flash content in a 
browser window, and a JavaScript file labeled AC_OETags.js that lets your SWF file play automatically in active 
content-compliant browsers. 

To publish a Flash document for the web:

1. Start Flash and open the document you want to publish.

2. Make sure nothing on the Stage is selected (Edit > 
Deselect All). 

3. In the Properties panel (Window > Properties), expand 
the Publish section (Figure 1).

In the Properties panel, you can select the Target runtime 
for the document and select the ActionScript version that 
matches your document.

4. Click to open the Target menu (Figure 2).

You can publish the document for the Flash Player 
runtime, as an Adobe AIR application, or for playback on 
a device running Flash Lite. For web publishing, you 
select a target version of the Flash Player.

You can publish a document for the most current version 
of the Flash Player or for older versions of the Flash 
Player. 

Note: Some features available in an ActionScript 3 
document may not run properly in older versions of the 
Flash Player. It’s usually best to publish for the most 
current version of the Flash Player.

5. Select a target Flash Player version.

Figure 1 Properties panel, Publish section

Figure 2 Target menu
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6. Click Publish Settings in the Properties panel.

The Publish Settings dialog box appears (Figure 3). It 
shows the most recently selected options. Notice you can 
also select the target runtime and ActionScript version in 
the Publish Settings dialog box.

The default, Flash publishes a Flash (.swf) file, and an 
HTML Wrapper. These are the correct selections if you 
are publishing your content to run in a web browser. 

7. In the list of publish format options, make sure the Flash 
(.swf) and HTML Wrapper options are both selected.

8. Click on the Flash (.swf) option to display the Flash 
publish settings on the right (Figure 4). Be careful not to 
deselect the option.

The default location for published files is to place them in 
the same location as the FLA file. To select a new 
location for the published files, you can click the folder 
icon beside the Output File text box, navigate to the new 
location, and click Save.

You can adjust the JPEG image quality. A higher value 
produces better looking images and larger files.

To make highly compressed JPEG images look 
smoother, select the option Enable JPEG Deblocking. 
This reduces artifacts resulting from JPEG compression. 

To set the audio sample rate and compression for all 
streaming sounds or event sounds in the SWF file, click 
the current Audio Stream or Audio Event setting and 
select new options as needed. 

Note: A streaming sound plays as soon as enough data 
for the first few frames downloads; it is synchronized to 
the timeline. An event sound does not play until it 
downloads completely, and it continues to play until 
stopped.

To override settings for individual sounds specified in the 
Sound section of the Properties panel, select the option 
Override Sound Settings. 

Note: If the Select Override Sound Settings option is 
deselected, Flash scans all stream sounds in the document 
(including sounds in imported video) and publishes all 
stream sounds at the highest individual setting. This can 
increase file size if one or more stream sounds has a high 
export setting. 

To export sounds suitable for devices, including mobile 
devices, instead of the original library sound, select the 
option Export Device Sounds. 

Figure 3 Publish Settings dialog box

Figure 4 Flash (.swf) publish settings
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9. Click the HTML Wrapper option on the left to display 
the HTML publish settings on the right (Figure 5). Be 
careful not to deselect the option.

You can select the template to use for creating the Flash 
HTML page the contains your SWF file. A Flash HTML 
template is a file that contains HTML code and flexible 
template code consisting of a special type of variables 
(which differ from ActionScript variables). When you 
publish a SWF file, Flash replaces these variables with 
the HTML publish options you select in the Publish 
Settings dialog box and produces an HTML page with 
your SWF file embedded.

If you are publishing to Flash Player version 4 or later, 
select Detect Flash Version. Flash version detection 
configures your document to detect the version of Flash 
Player that the user has and sends the user to an 
alternative HTML page if the user does not have the 
targeted player.

By default, the file dimensions are set to match that of the 
movie you’re publishing. You can specify new 
dimensions in pixels or as a percent of the current movie 
size.

There are four Playback control options (Figure 6). 
These include:

• Paused At Start pauses the SWF file until a user 
clicks a button or selects Play from the shortcut 
menu. (Default) The option is deselected and the 
content begins to play as soon as it is loaded.

• Loop repeats the content when it reaches the last 
frame. Deselect this option to stop the content when 
it reaches the last frame. This is on by default. 

• Display Menu shows a shortcut menu when users 
right-click (Windows) or Control-click (Mac OS) the 
SWF file. To show only About Flash in the shortcut 
menu, deselect this option. This option is selected by 
default.

• Device Font substitutes anti-aliased (smooth-edged) 
system fonts for fonts not installed on the user’s 
system. 

To determine the trade-off between processing time and 
appearance, you can open the Quality menu and select 
from six quality options that range from Low to Best 
(Figure 6). 

Figure 5 HTML publish settings

Figure 6 HTML playback and Quality options
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To modify the style of the window that contains your 
HTML file, you can open the Window Mode menu 
(Figure 7) and select from four window options:

• Window uses the HTML background color behind 
the content.

• Opaque Windowless sets the background of the 
Flash content to opaque, obscuring anything under 
the content. Lets HTML content appear above or on 
top of content.

• Transparent Windowless sets the background of the 
Flash content to transparent, allowing the HTML 
content to appear above and below the content. This 
requires viewing in a browser that supports 
windowless content.

• Direct turns on hardware acceleration. By default 
this is turned off. 

You can use the settings in the Scale and Alignment 
section of the HTML publish settings (Figure 8) to 
control how the SWF content is aligned in the HTML 
page. You can also specify if and how a browser scales 
the SWF content when a user changes the size of their 
browser window. 

10. Click Publish at the bottom of the Publish Settings dialog 
box.

Flash publishes files in the same folder as your FLA or to 
another output location that you specified. 

11. Click OK to save these settings for the current file and to 
close the Publish Settings dialog box.

Note: After setting publish options, you can choose 
File > Publish to publish without opening the Publish 
Settings dialog box.

12. To view the published document, open the folder that 
contains the published file and double-click the HTML 
file. 

The HTML file opens in your default web browser and 
displays the SWF content.

Figure 7 HTML Window Mode menu

Figure 8 HTML scale and alignment settings
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Publishing a Windows or Mac OS projector file

To create a self-contained application file that runs without the Flash Player installed, publish your Flash document as 
a Windows or Mac OS projector file.

To publish a projector file:

1. Start Flash and open the document you want to publish.

2. Make sure nothing on the Stage is selected (Edit > 
Deselect All). 

3. In the Properties panel (Window > Properties), expand 
the Publish section.

4. Click Publish Settings to open the Publish Settings dialog 
box.

5. Select Win Projector or Mac Projector from the list of 
publish format options (Figure 9).

6. Click Publish to publish the projector file, or click OK to 
save your publish settings and publish at a later time.

Figure 9 Publish format options

Publishing an Adobe AIR application

You can also publish Adobe Flash Professional documents as Adobe AIR applications. The Adobe AIR runtime 
makes it possible to deploy your Flash movie as a stand-alone desktop application that runs without opening a web 
browser. You can also publish Adobe AIR applications that run on popular mobile devices, including Android phones 
and tablets as well as iOS devices (iPhones and iPads). You can even create an Adobe AIR app that runs on your 
television.

To publish an Adobe AIR application:

1. Start Flash and open the document you want to publish.

2. Make sure nothing on the Stage is selected (Edit > 
Deselect All).  

3. In the Properties panel (Window > Properties), expand 
the Publish section.

4. Click Publish Settings to open the Publish Settings dialog 
box.

5. Select Flash (.swf) from the list of publish format options 
(Figure 10).

Figure 10 Publish format options
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6. In the Publish Settings dialog box, open the Target menu 
(Figure 11). 

7. Select a target runtime option that matches your target 
device, such as AIR 3.2 for Anroid.or AIR 3.2 for 
Desktop.

8. Click Publish.

The AIR Settings dialog box opens to the Signature tab 
(Figure 12). The first thing you need to do is select or 
create a certificate for the AIR application.

9. Click Create (Windows) or New (Mac OS) to create a 
new certificate.

The Create Self-Signed Digital Certificate dialog box 
(unamed in Mac OS) appears (Figure 13). All fields must 
be filled in to create the new certificate

10. Complete the form, including the password fields. 

11. Click in the Save As text box and enter a name for the 
certificate.

12. Click Browse (Windows) or the folder icon (Mac OS), 
select a target location for the new certificate, and click 
Save.

13. Click OK to create the certificate.

A confirmation message appears when the certificate is 
created.

14. Click OK to close the message.

15. Click in the Password text box and enter the password 
you created for the new certificate.

Figure 11 Publish Settings Target menu

Figure 12 AIR Settings dialog box

Figure 13 Create Self-Signed Digital Certificate 
dialog box
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16. Click the General tab in the AIR Settings dialog box.

You can enter a file name for the AIR installer file (.air) 
and enter a name and version number for the application 
(Figure 14).

You can include other information, including a 
description and copyright messaging. 

17. Click Publish to create the AIR application or click OK 
to save your publish settings and publish at a later time.

Flash publishes the AIR application and a message 
appears when the process is complete.

18. Click OK to close the message, and then click OK twice 
to close the AIR Settings and Publish Settings dialog 
boxes.

19. Open the folder you designated as the location for the 
published AIR application. 

The folder contains the AIR installer file (Figure 15). 
You share this file with users who can double-click the 
AIR file to install and run the application. 

Figure 14 AIR Settings dialog box, General tab

Figure 15 Published AIR application files
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Exporting Flash content as an image

Sometimes you may want to export Flash content as an image for use in another document. You can export Flash 
content in JPEG, PNG, or GIF format. 

To export Flash content as an image:

1. Start Flash and open the document you want to publish.

2. Make sure nothing is selected on the Stage. 

3. Open the Properties panel (if it is not already open) and 
expand the Publish section.

4. Click Publish Settings to open the Publish Settings dialog 
box(Figure 16).

5. Select a graphic file type for the image in the list of 
publish format options in the Publish Settings dialog box.

6. If you want to change the names of the image, enter new 
name in the Output file field.

By default, every file type uses the same name as the 
FLA file. Only the file extensions are different.

7. Click Publish to create the image.

By default, files are published in the same folder as the 
FLA file.

Figure 16 Publish Settings dialog box
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